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H Recent localizer usable Show Counts.
) Favorite 9 tL_mpr_lmm_p2_pos50 usable Show Counts
oD Beas =it ti_mpr_imm_p2_pos50 usable Show Counts.
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You are an owner for this project. woL MR W072 ARC
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An fMRI Study of Affective Regulation and Attentional Control in woL MR WOB7 ARC # Hed & Previous & Highlight all [ Match case
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SELECT
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Description
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Data Archive
Home New ™ Upload ~ Administer Tools ™
Search
Launch Uploader
NUNDA currently contains 35 Projects, 684 Subjects, and 335 Imaging Sessions.
— Projects
Tl Recent Subjects | MR PET | CT
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- Other prejects

F

Stored Searches

* Neurology (3)

+

Data

Projects

Neuromorphometry by Computer Algorithm NUSRG

Project ID: NMorphCH PI: John Csernansky

Neuromorphometry by Computer Algorithm NUSRG protocol Session ids:
yymmdd_CHzzz2 £z

Request access ta this project.

Ragin ACE Study
Project ID: ACE PI: Ann Ragin
Request access to this project.

PharmacoMRI of Parkinson's disease: a pilot study of drug effects on

connecti
Project ID: pd_pharmacomri
Request access to this project.

PI: Darren Gitelman

NUBridge: Prenatal Stress and Early Brain Development (12 & 24 months)
Project ID: NUBridge PI: Lei Wang

Specific aims of the project are to examine the effects of prenatal exposure to stress
on longitudinal devalopmenta\ patterns of brain growth in early develo ...

Rannast accass tn this nenisct

Recent Data Activity

: « Physiology (3)

TP MR 24361 ARC
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pd_phar... MR 008b ARC _|

NUBridge MR 120216_001M MOD

NUBridge MR Test BW_Nordahl... ARC

NUBridge ™R Test_BW_Gilmore... ARC

NMorphCH MR 120208_CH7059b ARC

PPA MR CH15a ARC .

PPA MR P&6a ARC I 4
SA MR SAl148a ARC a

‘WoL MR WO71 ARC

S Endocrinology
Davee MR DODD2_T3b ARC

Davee MR DOO1_T3b ARC

Davee MR DO16_T1lb ARC ~
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" Neuromorphometry by Computer Algorithm NUSRG
‘Recent
+|-Faverite w Access " Manage " Pipelines ” History Add 4
. Upload Images
My projects TS NMarshCH View Prearchive
Other projects Description: Heuromorphometry by Computer Algerithm NUSRG protocol Session ids: Add to Favorites
+| Stored Searches yymmdd_CHesss_s2 Download XML
) Dats PI: Csernansky, John Download Images
Investigators: Wang, Lei
| Edit Details | | pelete | | Manage custom variables
Subjects MR Sessions X/ |
1 2 3 next> last>> 40 4 1 0f3Pgs (100 Rows)
Subject M/F Hand YOB Group MR Sessions 15 =
CHO090_01 | M R 1982 M2 2z
CH0446_01 |F R 1986 |mM2 1
CHO446_02 | M R 1590 M2c 1
CH1840 [ R 1581 |mz £
CH2917 [ R 1581 |[mMz 3
CH3098 F R 1972 [mM1 4
CH3183 [ R 1978 | M1 3
CH4440 W R 1584 | M1 1
CH5874 F R 1983 |[mM2 1
CH5994 F R 1987  [mM2 1 L
CH7059b M R 1979 Mz 1 1
CH7098a M R 1530 M1 1
CH7131b F R 1571 Mz 2
CH7172a M R 1578 [M2 3
CH7176a |F R 1982 M1 2
CH7193b M L 1970 M1 3
CH7202b F R 1584 Mz 2
CH7216a F R 1863 M1 1
CH7238a | M L 1576 | M1 1
CH7259b M R 1977 M1 3
CH7264b M R 1365 M1 3 A
| CH7272b M L 1573 M1 2
CH7292b M R 1565 |[mz 1
CH7307a |M R 1976 [M1 3
CH7316a F L 1975 M1 3
CH7317b M R 1530 Mz 1
CH7353a F R 1580 M1 5 4
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CH7496a | M R 1967 |mz 1 al
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+ Stored Searches Date Added 2009-04-24 00:37:38.0 (admin) View XML
Gt Birth year 1972 [Z Add Experiment
Gender Female Download 4
Handedness Right Pr Email
Education 14 ¥ Share
Race [=
R R Sucasian =] Manage Files
Height (inches) 64.0 -
" Delete
‘Weight (Ibs) 145.0
Recruitment Source Rehab Clinic
Group M1
Experiments
Date Experiment Project Label

2009-01-05 MR Session NMorphCH 090105_CH3098
2009-02-27 MR Session NMorphCH 090227_CH3098_fMRI
2009-08-21 MR Session NMorphCH 0390821 _CH3098_NCEPTS
2011-04-14 MR Session NMorphCH 110414 _CH3098
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& 9 ‘ [ nunda northwestern edu/nunda/app/action/DisplayltamaA nent/xnat¥3AmrSessionData/search c | ‘ - icewise Iinearregressworﬁ| O
| SmartBookmarks [£) MostVisited & LatestHeadlines | | News | Journals | Research RSS | | Quicklink [ Inglés [ Blackboard Learn m Morthwestern Collabor_
N D User: admin {Logout) (Edit) {(Report 3 problem) Advanced
Northwestern University Neuroimaging
Data Archive
Home New ™ Upload ~ Administer Tools
PROJECT: NMorphCH > SUBJECT:CH3098 > 110414_CHZ038
= Projects
+/-Recent MR Session: 110414_CH3098
+|-Faverite
My projects Projects
Oth, t: % i
= prajacts Accession #  NUNDA_EO0S7S Subject: CH3098 ¥ ean
+} Stored Searches _Da- £31: . View »
Date Added 201170414 15:31:07.0 Gender: Femals Untoad i
+! Data (pvoss) Handedness: Right ploa:
Date: 2011-04-14 Age: 39.00 Download »
Time: 11:54:51 P Email
Operator: Jill/Sam ¥ Share
Scanner: MEDPC SIEMENS TrioTim # Launch Pipeline
Marker: vitamin e capsule left eye Ea
" Manage Files
Stabilization: head pads -4
Receiver Delete
P 12 channel
coil:
Notes:
Scans
Scan Type Usability Files Note
AAHScout usable DICOM (128 files, 14.13 Mb) SHAPSHOTS (2 files, 123 Kb)
MPRAGE usable DICOM (4 files, 457 Kb) SNAPSHOTS (2 files, 23 Kb)
MPRAGE usable DICOM (176 files, 33.63 Mb) SHAPSHOTS (2 files, 335 Kb)
MPRAGE usable DICOM (176 files, 33.54 Mb) SHAPSHOTS (2 files, 2351 Kb)
t2_spc_1mm_(T2-SPACE) usable DICOM (176 files, 33.81 Mb) SHAPSHOTS (2 files, 335 Kb)
2p2d_Test Bold_ usable DICOM (5 files, 1.86 Mb) SNAPSHOTS (2 files, 114 Kb)
ep2d_bold_nback usable DICOM (137 files, 51.34 Mb) SHAPSHOTS (2 files, 556 Kb)
=p2d_beld_nback usable DICOM (137 files, 51.26 Mb) SHAPSHOTS (2 files, 555 Kb)
ep2d_bold_nback usable DICOM (137 files, 51.26 Mb) SHAPSHOTS (2 files, 557 Kb)
0 RESTING STATE usable DICOM (164 files, 251.32 Mb) SNAPSHOTS (2 files, 2.09 Mb]
1 RESTING STATE usable DICOM (164 files, 251.23 Mb) SNAPSHOTS (2 files, 3.10 Mb)
2 DTI usable DICOM (35 files, 57.46 Mb) SNAPSHOTS (2 files, 4.44 Mb)
3 DTI usable DICOM (35 files, 57.44 Mb) SNAPSHOTS (2 files, 4.44 Mb)
4 Tz-fl3d-tse_p3_g4s! usable DICOM (64 files, 5.15 Mb) SNAPSHOTS (2 files, 84 Kb)
5 Bold Tobizss-EP2D_emction usable DICOM (400 files, 191.00 Mb) SNAPSHOTS (2 files, 944 Kb)
6 MPRAGE usable DICOM (176 files, 32.97 Mb) SHAPSHOTS (2 files, 454 Kb)
=History
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AVIN N L ]

x zotero

Subject
MR Session

Scan

m




https://nunda.northwestern.edu/

NORTHWESTERN
UNIVERSITY

File Edit View History Bookmarks Tools Help
| # Check TextStaus | EnunDA

€D |@ nunda northwestern.edu/nundafapp/template/imageUplo
e

d.vm

L

- cewise linear regression £ || @ || fr | 1 " Data Ca ptu re
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Northwestern University Neurcimaging
Data Archive

Home New ™ Upload ~ Administer ~

Tools ~

: ompressed upload
—! Projects

 Webu P load
Raw image files can be zipped (.zip or tar.gz) and upleaded using the form. This toal
Favorite

currently supports DICOM and ECAT files. Selacting 'Prearchive’ vill place your images

S

Advanced

into a temporary holding space. You will then have the ability to review the details and
My projects match the data to the proper subject & sassion id. If you are confident the data will be
mapped properly, you can directly 'Archive’ the files and specify whether the resulting
: Other projects session should go inte a quarantine state.
+/ Srored Searches Project SELECT -
+/ Data Destination

Prearchive () Archive in quarantine ) Archive no quarantina
File

ploader Applet
DICOM and ECAT files can be uploaded vis =n online upload tool.

PICOM C-STORE Service Class User

Any DICOM C-STORE SCU, including scanner consoles or DICOM applications like DsiriX
or DicomBrowser, can send files directly to this server.

DICOM C-STORE receiver (SCP) Specifications
® Host Name: nunda.northwestern.edu
® Port: 104
* AE Title: NUNDA

Start DICOM Browser

N XNAT
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| [# nundanorthwestern edu/nunda/app/action/XDAT ActionRouter/xdatactionfedit/search_elementxnat%3AmrSessionDatafsearch_fieldpnat®3AmiSessionData IDjsearc ~ ‘ O-

1. Data capture

Image Session Modification Form

- 2. Quality control

Subject cHsa74 [

Session 090422-CHsE74 [F

Date April ¥ 22 ~ 2009 -
Scanner CAMRI Trio 3T | 2] [SIEMENS TrioTim CAMRI Tris 3T)

Acquisition Site

Add More Session Details

Scans

Scan TypeE Quality Note
- localizer ~ usable - 5 files, 0.4 MB
-2 EP2D_emotion - 402 files, 189.8 MB
4 3 T - 178 files, 33.3 MB
- . T - 178 files, 33.2 MB
- s T2 « questionable v slightly fuzzy unable to repeat - study ended 178 files, 33.5 MB
FEar ep2d_diff_b&00_35dir_2mm « usable - 37 files, 62.0 MB
- 7 ep2d_diff_b&00_35dir_2mm ~ questionable » stopped study, subject crying in scanner 26 files, 43.8 MB

Additional Notes

Subject started crying in scanner. Ended study
session.
Notes

“CXNAT
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N l PET, analyzed data, |-smin Loaoun tedit) (Report a problem)

Click ‘Search’ to

openviewcustom ' 1 Data Capture

search dialog.

ATScreen_report_xnat_projectData.vm/search_element/xnat;

! Inglés F.A Blackboard Lez

-~ 2. Quality control

| v

and custom non-

s image types

o 3. Data exploration &

Neuromorphometr r by Computer Algorithm NUSRG

+ Recznt d I d
+' Faverite. W Access H I anage H Pipelines " History Add 4 OWn Oa

Upload Images

Projects

~My projects

1D: NMorg nCH View Prearchive
Other projects Description: Neuro norphometry by Computer Algerithm NUSRG protocol Session ids: Add to Favorites
Stored Searches yymmdd_CHesss_s2 Download XML
PI: Csern |nsky. John

+ Data Download Images

Investigators: Wang| Lei

| Edit Details | | Delets ||| Manage custom variables

Subjects MR Sessions B

1.2 3 4 5 next> last>> 30 .  1of11Pgs (204 Rows)

MR 1D Date Subject Age Scanner Scans B =
ep2d_bold_connect(1),
081219_CH5994 2008-12-19 | CH5994 21 MRC35013 ep2d_diff_ba00_z5dir_2mm(2), EP2D_emotion(1),

localizer(1), T1(2), T2(1], tse_p3_s4sl(1)
=p2d_bold_connact(1), ep2d_bold_test(1),
090105_CH3098 2009-01-05 | CH3098 37 CAMRI Trio 3T | ep2d_diff_bg800_35dir_2mm(2), EP2D_emotion(1),
localizer(1), T1(2), T2(1). tse_p3(1), tse_p3_64sl(1) £
ep2d_bold_connect(1), ep2d_bold_episadic(1].
ep2d_bold_nback(2), ep2d_bold_test(1),
090119_CH7957 2009-01-19 | CH7957 35 CAMRI Trio 3T | ep2d_diff_bg800_35dir_2mm(2), EP2D_emotion(1),
localizer(1), MPRAGE(1], PhoenixZIPReport(1]),
T1(2), T2(1), tse_p3(1), tse_p3_64sl(1)
=p2d_bold_nback(7), ep2d_bold_test(1), A
090202_CF 7259b 2009-02-02 | CH7259b |32 CAMRI Trio 3T | ep2d_diff_bg800_35dir_2mm(2), EP2D_emotion(2),
localizer(2), T1(2). T2(1). tsa_p3_64sl(2)
ep2d_bold_connect(2), pp2d_bold_nback(3),
=p2d_bold_test(1), ep] d_diff_ba00_35dir_2mm(2),

090223 _CH7637 2009-02-232 | CH7637 38 CAMRI Trio 3T EP2D_emotion(1), lochlizar(1), MPRAGE(1), T1(2),
T2(1), tse_p2_64sI(1)
}7_CF3098_fMRI 2008-02-27 | CH3098 37 CAMRI Tric 3T | ep2d_bold_nback(3, localizer(1)
H 2d_bold, e 2), 2d_bold_nback(3),
Click here or on sp2d_bold_cannagf(2), ep2d_bold_nback(z)

ep2d_bold_test(1/, ep2d_diff_b800_25dir_2mmi{2),

the data ID to )5=21.0090_01 2005-02-05 | CHO090_01 | 27 CAMRI Trio 3T EE?.DTe.mOf:;_(;‘;II(TThzar(1)' iy e
. . mpr lmm_p2_pos50_S3_DIS2D(1),

view a detailed o The columns ni.p2_pos50_53_DIS3D(1),

rt. Click the )5_CHO090_01_DIS | 2005-03-05 | CHO090 N e s
report. that appearina nm_p2_pos50_S4_DIS3D(1)
. . . . _connact(2), ep2d_bold_nback(3), A
ids to view I|st|ng are test(1), ep2d_diff_b200_35dir_2mm(z2),
details »a_CH8357 2009-03-24 | CHB357, A PRSI (5] T2l

- tailored for the i -

— data type. -

x zotero
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File Edil View
| session: 110414_CH3008

ry Bookmarks

1. Data capture

=

€« 9 ‘@ nunda.northwestern.edu/nunda/app/action/DisplayltemAction/search_slement/xnat¥3AmrSessionData/search < B ‘cewiseIinearregresswor):'| D A
> = .
| Smart Bookmarks [} MostVisited 3/ LatestHeadlines | | News | Journals | | Research RSS | | QuickLink [ Inglés [ Blackboard Learn m Morthwestern Collabor_ El 2 Q u aI Ity CO ntrol
]
N ! ! N D g User: admin (Logout) (Edit) (Report a problem) Advanced E
Northwestern University Neuroimagi 5
orthwestern University Neuroimagin,
. 3. Data exploration &
Home New ™ Upload ~ Administer Tools L]
PROJECT: NMorphCH > SUBJECT:CH3098 > 110414_CHZ038
= Projects
MR Session: 11041_CH3008 download
+|-Faverite
——= _ -
’ i 5 = ﬂ
Other projects Accession #  NUNDA_EQ057S Subject: CH3098 @ NUNDA - Morzilla Firefox g
+i-Stored Searches 2011-04-14 15:31:07.0 Gender: Famale 4
Date Added i
+! Data e (pvoss) Handedness: Right 4 o c ﬁ l E ﬁ?ﬂ T
Date: 2011-04-14 Age: O 3 -
Time: 11:54:51 Email
Operator: Jill/Sam ¥ Share @ NUNDA =
Scanner: MEDPC SIEMENS TrioTim & Launch Pipeline
Marker: vitamin e capsule left eye Ea ) Type T -
Stabilization: head pads ) Manage Files
Receiver Delete Data R -
coil: 12 channel _—l -
Run 3 - == g
Notes: ¢ NUNDA_EO...
Wiewy Tranzverse - I File View
Displa
Scans play Stack -
v N
Scan Type Usability Files Note M radiolagic GO
1 AAHScout usable DICOM (128 files, 14,13 Mb) SNAPSHOTS (2 files, 123 Kb) [l §
2 MPRAGE usable DICOM (4 filas, 457 Kb) SNAPSHOTS (2 files, 23 Kb)
B3 MPRAGE usable DICOM (176 files, 33.63 Mb) SNAPSHOTS (2 files, 395 Kb)
5 - f
Session information Help
SESSION ID: -
LAB ID: El
HAPE: B
AGE: 26.24
GENLER: Female |
Image HANDEDNESS: Right
ACH. DATE: 2009-04-22
SCANNER: CAMRI Trio 3T
STABITIZATICN: L
REF. HARKER:
INVESTIGATOR: - f C
4 I, L Coordinates (Native):
= ot = Dane 0, 0,132:.00
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File Edit View History Bookmarks Tools Help I D ata Ca t re
| Check TextStaus | E session: 090422 cHss74 x NA— - - = . u
€ > | nunda northwestern.edu/nunda/app/action/DisplayltemA /search_element/xnat%3AmrSessionData/sea [ | | - wcewise linear regressior Pl £
A —
|| Smart Bookmarks (2 MostVisited | LatestHeadlines | | News | | Joumals | | RessarchRSS | | QuickLink Inglés [0 Blackboard Leamn E‘ Northwestern Collabor_ 3 2 I 't t I
N D User: admin {Logout) (Edit) (Report a problem) Advanced 3 L] u a I y CO n ro
Northwestern University Neuroimaging .
Data Archive
Home New ™ Upload ~ Administer ~ Tools ~ a a eXp O ra I 0 n
]
PROJECT: NMorphCH > SUBJECT:CH5874 > 090422-CH5874
Projects
+ Recent MR Session: 090422-CH5874 d OWﬂ IO ad
+ - Faverite
My projects Projects
i 7 Otherprojects Accession #  NUNDA_E00D11 Subject: CH5874 ¥ ean
& Stored Saarches Date Added  2009-04-29 13:30:26.0 (lai) Gender: Female View 4 -
+'Data Date: 2009-04-22 Handedness: Right Upload 4 0 I I I a g e p ro CeSS I n g
Time: 13:22:43 Age: 26.00 Download 4
Operator: Nondas P Email - =
Scanner: CAMRI Trio 3T SIEMENS TrioTim 3 I e I I n e S
Marker: Vitamin E above left aye peline
ﬁtabl_llzatmn: Hean: pads S e e Files
eceiver c 13-
b - Delete
Notes: Subject started crying in scanner. Ended study session.
Scans
Scan Type Usability Files Note
1 localizer usable DICOM (3 files, 424 Kb) SNAPSHOTS (2 filas, 17 Kb)
2  EP2D_emotion usable DICOM (400 files, 188.90 Mb) SNAPSHOTS (2 files, 948 Kb)
3 Ti usable DICOM (176 files, 33.06 Mb) SNAPSHOTS (2 files, 250 Kb)
4 T usable DICOM (176 files, 32.96 Mb) SNAPSHOTS (2 files, 245 Kb)
5 Tz DICOM (176 files, 33.23 Mb) SNAPSHOTS (2 files, 298 Kb)  slightly fuzzy unable to repeat - study enc
6 ep2d_diff_b200_35dir_2mm usable DICOM (35 files, 57.23 Mb) SNAPSHOTS (2 files, 4.75 Mb)
7 ep2d_diff_bs00_35dir_2mm DICOM (24 files, 39.23 Mb) SNAPSHOTS (2 files, 4.58 Mb)  stopped study, subject crying in scanner
wHistory
«poweret_
4 (i} | r
x zotero



NUNDA PIPELINES
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NUNDA Pipelines

[l

[l

[l

[l

Currently Available Pipelines

The Front-End (How to Launch a Pipeline)

The Back-End (How the Pipeline Engine Works)
Live Demo (NUNDA Cooking Show)
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Currently Available Pipelines

Standard Structural Preprocessing (StdBuildNunda)
DICOM 2> Analyze reconstruction
MPRAGE averaging

FreeSurfer Segmentation and Surface Generation (FSBuild)

FSL Tissue Segmentation (FSLSeg)
Image segmentation into gray, white, CSF, tissue types
Resting-State Preprocessing (GenericBoldPreprocessingNunda)

Resting-state BOLD scan preprocessing

Includes QC outputs
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Currently Available Pipelines

1 Standard Structural Preprocessing (StdBuildNunda)
DICOM =2 Analyze reconstruction (16-bit 4dint)
T1 MPRAGE averaging

m Geometric distortion correction
m Averaging multiple acquisitions
®m Gain field correction

T2W/ TSE

m Geometric distortion correction
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Currently Available Pipelines

_
1 Standard Structural Preprocessing (StdBuildNunda)

1 FreeSurfer Segmentation and Surface Generation (FSBuild)

recon-all —all
® Subcortical segmentation and volume

m Cortical parcellation and volume, surface area, cortical thickness

® Currently requires pre-processed MPRAGE image as input, will soon accept
DICOMs
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Currently Available Pipelines

Standard Structural Preprocessing (StdBuildNunda)
FreeSurfer Segmentation and Surface Generation (FSBuild)

FSL G/W /CSF Tissue Segmentation (FSLSeg)

Segmenting MPRAGE with FSL
Requires pre-processed MPRAGE image as input
FSL BET — deletes non-brain tissue from input image

FSL FAST — corrects for spatial intensity variations — bias field or RF
inhomogeneities

FSL FAST — segments image into gray, white, CSF, tissue types, provides
volume
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Currently Available Pipelines

Standard Structural Preprocessing (StdBuildNunda)

FreeSurfer Segmentation and Surface Generation (FSBuild)
FSL G/W /CSF Tissue Segmentation (FSLSeg)

Resting-State Preprocessing (GenericBoldPreprocessingNunda)
Pipeline to pre-process BOLD scan types
Frame alignment to correct for asynchronous slice acquisition
Correction for odd-even slice intensity differences
Movement correction
Average of all the first frames
Transformations to standard atlas space
Includes QC
Intensity histogram of the normalized bold image

Movement plot (from motion correction)



NUNDA

MNorthwestern University Meurcimaging

Data Archive

- Prajects
'i' - Recent
+ - Favorite

My projects

E------l'_'h‘thf_lr projects
=+ - Stored Searches

https://nunda.northwestern.edu/

Launch Pipeline from NUNDA Web

User: kalpert {Logout) (Edit) (Report a problem)

Advanced

Home

New *™

Upload v

Administer ~

Tools =

PROJECT: Test Project > SUBJECT:BP27214 > 080427_BP27214

MR Session: 080427_BP27214

.iiw i Projects

Accession # MUNDA_EQ0S00 Subject: BP27214
Date Added 2011-11-22 18:30:44.0 Gender:
(kalpert) Handedness:
Date: 2008-04-27 Age: .
Time: 11:06:3%
Dperator: 15 A5
Scanner: MEDPC SIEMENS TrioTim
Acquisition
Site: Washington
Motes:

Actions

& edit

View

Upload

Download
PP Email
¥ Share

dﬁ Launch Pipeline
= Manage Files
-2 Delete

4
F
k

K

Navigate to your MR Session page, select “Launch Pipeline”

from the Actions Menu



806 NUNDA

@ nunda.northwestern.edu/nunda/app/action/XDATActionRouter/xdataction /Pipeline® . @'

Please select a pipeline to launch for 0B0427_BP27214

() FsL_SEG
Description: Pipeline for segmenting MPRAGE data
() FsBuild

Description: Plpeline for running reconall -all

D zenericBoldPreprocessingMunda
Descr, ' Fipeline to pre-process BOLD scan types. Includes the Functional Connectivity post-processing.
® stdBuildNunda

Description: Dicom to Analyze Reconstruction

i A\ .
._E{Zlnse#, [Submrt__a.

(pnwemd by
XNAT
“

Select the pipeline you wish to launch and click
“Submit”



an0o NUNDA

J@ nunda.northwestern.edu/nunda/app/action /ManagePipeline

StdBuild Pipeline: Session Parameters

Subject: BP27214
Project: Test (Alex)

**¥*Warning: StdBuildNunda pipeline has been run already. A rerun will overwrite the following reconstructions: 4DFP_NUNDA_E00900,
TSE_NUNDA_EOQ0900, T2_NUNDA_EQD900, and MPRAGE_*_NUNDA_EODS00. ***

sessionld: 080427 _BP27214

Min Number of Slices Needed to Reconstruct Sequence (changing this will change the sequences you can select below): 30

Include localizer
(NOT ENOUGH FRAMES)

M Include AAScout

Check scans to reconstruct:
E 2 (AAScout Quality: usable)

# 7 (AAScout Quality: usable)

Include localizer_aligned
(NOT ENOUGH FRAMES)

E Include t1_mpr_imm_p2_pos50
Check scans to reconstruct:
E 4 (t1_mpr_imm_p2_pos50 Quality: usable)
E S5{ti_mpr_imm_p2_pos50 Quality: usable)
E Include t2_spe_1mm_p2
Check scans to reconstruct:
g 6 (t2_spc_1lmm_p2 Quality: usable)
E Include tse_p3
Check scans to reconstruct:

E 8 (tse_p3 Quality: usable)

Include ep2d_bold_test
(NOT ENOUGH FRAMES)

Set session-specific parameters....




800

NUNDA
J@ nunda.northwestern.edu/nunda/app/action/ManagePipeline

g Include ep2d_diff_bB00_30dir_2mm

Check scans to reconstruct:
E 12 {ep2d_diff_bB00_30dir_2mm Quality: usable)
E 13 {ep2d_diff_bB00_30dir_2mm Quality: usable)
™ Include T2 star ep2d_fid
Check scans to reconstruct:
g 14 (T2 star ep2d_fid Quality: usable)
E Include tse_p3_64sl

Check scans to reconstruct:

W 15 (tse_p3_64s! Quality: usable)

MPR Process T1 Scans: ®ves O no

Choose MPR Scans to Process (align using b-spline interpolation, average if more than 1):
84 (ti_mpr_imm_p2_pos50 Quality: usable)

a 5 (ti_mpr_imm_p2_pos50 Quality: usable)

Parameters for MPR Processing:
Grad Unwarp? 8 Yes D Mo

Choose Map for Grad Unwarp {scanner gradient model): [ Awvanto (use for TimTrio) I"H

Atlas (711-2B) Representative Target: B TRIO_¥_MNDC {for young adults) O CAPIIO (for clder adults)

When the process Is complete, an emall will be automatically sent to k-alpert@northwestern.edu

Send additional confirmatien emalls to {use spaces to separate multiple addresses)

( Launch Selected ) ose )

And click “Launch Selected” to launch!

1

fpuwered by
XNAT



The Back-End

We harness the power of Quest, Northwestern’s
high performance computing cluster, to run
NUNDA pipeline processes
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NUIT Home » Research Computing Resources » Advanced Research Computing » High Performance

https: / /nunda.northwestern.edu/

Quest Computing Cluster

Computing * The Quest Cluster
4032 Intel

Nehalem Cores

High Performance Computing System - Quest

The University's high performance computing (HPC) system is referred to as Quest. H
University's secure Data Center facilities, it offers a large shared computational facilit

Designed as a general use cluster, Quest
supports the majority of HPC applications at
Morthwestern and is built to accommodate a
wide variety of codes with great economy.

Northwestern University
Intranet

Il [

University researchers and educators, including
postdoctoral researchers are eligible to applv for
an account to request an allocation of time on

Quest as computational investigators (CI's) for
the purpose of research or education.

4 login nades

— 2 mgmt nodes

3024 Intel
Westmere Cores

84

Information on the types of allocations
supported by Quest, application deadlines, and
required documentation can be found in the

Allocation Submission and Review Guidelines.

Quest Facts

Ranked among the TOP500 list of the fastest computers world wide, Quest's architec

4 storage nodes

QUEST
Storage

« Vendor: IBM iDataPlex
Parallel Filesystem: IBM GPFS

Management Network

DDR Infiniband QDR Infiniband

-
+« DDN DCS 9900 storage system: 100 TB available for projects on Quest
+ Interconnect: Infiniband DDR
o Number of Nodes: 504 (4032 cores)
o Processor: Intel Nehalem E5520, 64-bit, 8M Cache, 2.26 GHz, 5.86 GT/s Intel® QPI,
1066Mhz FSB
o Memory: Per node (Per Core) 48GB's (6GB's), Type: DDR3
s Interconnect: Infiniband QDR
o Number of Nodes: 252 (3024 cores)
o Processor: Intel Westmere X5650, 64-bit, 12MB Cache, 2.66 Ghz, 6.4 GT/s Intel® QPI,
1333Mhz FSB
o Memory: Per node (Per Core) 48GB's (6GB's), Type: QDR

nodes
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XNAT Pipeline Engine

/NUNDA Server\

Pipeline

Engine

" v

0 Installed and runs on Quest nodes, not on the NUNDA server

0 Itis a java-based engine that uses XML workflows to call local
programs/scripts
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XNAT Pipeline Engine
=

<?xml version="1.0" encoding="UTF-8"7>
- kpipeline xmins:fileUtils="http:/ /www.xnat.org/java/org.nrg.imagingtools.utils.FileUtils"
kmlins:nrgString="http:/ fwww.xnat.org/java/org.nrg.pipeline.utils.StringUtils"
xsi:schemalocation="http://nrg.wustl.edu/pipeline ..\..\schema\pipeline.xsd"
xkmins:xsi="http: / /www.w3.org/2001/XMLSchema-instance" xmins="http:/ /nrg.wustl.edu/pipeline” =
zname=>StdBuildNunda </name:x
=<location= /var/lib/nunda_pipeline/catalog/build-tools</location:-
<description=Dicom to Analyze Reconstruction</description=
- =documentationz
- <input-parameters>
- <parameter:
znamex=sessionId</namex=
- zvalues>
<schemalink>=xnat:mrSessionData.label</schemalink>
= /values=
<description>=The MRSession Label</description=

</parameter>
</input-parameters:=

</documentation=
=xnatlnfo appliesTo="xnat:mrSessionData"/>
<outputFileNamePrefix=“~concat(/Pipeline/parameters/parameter[ name="builddir']/values/uniqueftext
D Ins (),'/", /Pipeline/parameters/parameter[name="sessionld']/values/unique/text
(),'/", /Pipeline/parameters/parameter[name="sessionld']/values/unique/text() )" </outputFileNamePrefix=
<loop xpath=""/Pipeline/parameters/parameter[name="allstudies']/values/list~" id="alls"/ >
N <loop xpath=""/Pipeline/parameters/parameter[name="studies'] fvalues/list™" id="studys"/>
|:| I‘l' | - <parameters> GI
- «parameter:
<name>workdir</name=
p rq - «<values>
<unigue>="~concat(/Pipeline/parameters/parameter[name="builddir'] /values/unique/text
(), /', /Pipeline/parameters/parameter[name="sessionIld'] /values/unique/text())~ </unigue=
<fvalues>
< /parameter=
- =parameter:>
<name:>processeddir</namsx>
- <values>
<unique>=~concat(/Pipeline/parameters/parameter[name="workdir'] /values/unique/text
(),'/PROCESSED') " </unique=
</values=

[parameter XML Workflow Example: StdBuild




https://nunda.northwestern.edu/

XNAT Pipeline Engine
B
/NUNDA Server

NUNDA
Web application

Pipeline

REST API .
Engine

"

0 Installed and runs on Quest nodes, not on the NUNDA server

0 Itis a java-based engine that uses XML workflows to call local
programs/scripts

0 It communicates with XNAT (NUNDA server) via the REST API



https:/ /nunda.northwestern.edu/

The REST (REpresentational State Transfer) API

REST APl enables a client to interact with the server in a
standardized fashion
A client makes a request to the server, the server returns a response to
the client
Requests can be GETs, POSTs, PUTs, DELETEs, etc.

Requests and responses are built around the transfer of representations
of resources

A representation (for example, an XML document) communicates the
state of a resource

E.g., a client GETs a resource XML, which represents an MRSession, from the
server, changes the fields for scanner type and date, and then PUTs the
updated resource XML back onto the server

A client (not on the server) is able to change the state of the MRSession resource
This way, a client (with proper authentication!) can pull information

from and push information to NUNDA -2 no need to run
processing on the server



Communicating with Quest

AUNDA Server K \\

Parameter
File
NUNDA

Web application

When the user launches a pipeline, the NUNDA

Pipeline
web application/web engine generates an XML Engine
parameter file, which stores all project and session
parameters for the pipeline, and calls a scheduler Quest Cluster

script




Communicating with Quest

AUNDA Server K

Parameter
File

NUNDA
Web application

PBS Script

&

The scheduler script creates a PBS script to launch
the XNAT Pipeline Engine for this particular pipeline
and then copies (via scp) this PBS script and the

XML parameter file onto Quest

=

Pipeline
Engine

Quest Cluster



Communicating with Quest

AUNDA Server K

PBS Script

Parameter

File Runner
NUNDA Script
Web application

N, =

The scheduler script also creates a runner-script Pipeline
that will execute the PBS script on Quest Engine

Quest Cluster



Communicating with Quest

AUNDA Server K \

PBS Script

Parameter

File Runner
NUNDA Script

Web application

\ N

The scheduler script then executes this runner-script on Pipeline
Quest via ssh: Engine

ssh usernamelquest.it.northwestern.edu ‘bash -s’ < runner.sh

The runner script executes the PBS script on Quest Quest Cluster
using Quest’s XNAT Pipeline Engine



Communicating with Quest

o

NUNDA Server /

PBS Script

Parameter
Runner

NUNDA
Web application

B =

The pipeline communicates with the NUNDA wek

Pipeline
application using XNAT’s REST API Engine
POST-ing pipeline’s progress
GET-ting DICOMs/images from NUNDA server Quest Cluster

PUT-ting results onto NUNDA server



- How to Launch a Pipeline

Once you have MR Sessions in a project on
NUNDA, you can begin running pipelines
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Step 1: Add Pipeline to Your Project
S =

N ! ! N D ﬂ User: kalpert (Logout) (Edit) (Report a preblem) Advanced

MNorthwestern University Neuroimaging

Data Archive .
| Home New ™ Upload v Administer ~ Tools ~ |
= Projects
. Test (Alex)
+ Recent
+ Favorite Details || Access || Manage ||l (1]
! :
My projects
Pipelnes for TP
[ Other projects
+ Stored Searches Applies To Generates Name Description
+ . Data -2 Edit Details MR Sesslons FSL_Segs FSL_SEG Pipeline for segmenting MPRAGE data
- Edit Details MR Sesslons Freesurfer, APARCS ASEGS FSBuild Pipeline for running reconall -all
P Edit Details MR Sessions GenericBoldPreprocessingMunda Pipeline to pre-process BOLD scan types. Includes the Functional Connectivity post-pro

4eidi Mare Pipelines

Lenser i)

Subjects B

==first =prev 41 next> last>> 1 of 1 Pgs (14 Rows)

Subject M/F Hand YOB Group MR Sessions CT Sessions

0507_5120_4 u u 1

090503_CH7436 U v

12 M A 2009 21 5 1

24159 u u 1

24361 u u 1

71318_3 U U 2

BP27214 u u 1

MAMRATY rRATEREE (N (N 1

Navigate to your project page, select the “Pipelines” tab, and click “Add More Pipelines”



Test (Alex)

Details | Access | Manage : History
Addiional Fipatngs far TF
Applies To Generates Marre Description
Add tails = MR Sessions StdBulldNunda.xml | Dicom to Analyze Reconstruction

| Show Project Pipelines |

Actions

Add 3
Upload Images
View Prearchive

Add to Favorites
Download XML
Download Images

-Select “Add”
next to the
pipeline you
wish you add.

-Set any
project-wide
parameters for
the pipeline.

-Click “Add”

8OO NUNDA

Add StdBuildNunda Pipeline to Project TP:

| Please set the following parameters:
(If a pararmeter can take multiple values, please enter a comma separated list of values for that parameter.)

1 No Project-Wide Parameters To Set Up!

N b
(Add_j {Eancel_'j

@ nunda.northwestern.edu/nunda/app/action/ManagePipeline?task=projectpipeline&templa 2 @T

N XNAT
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Step 2: Launch Pipeline on MRSession
N

NUNDA

MNorthwestern University Meurcimaging

Data Archive

- Prajects
'i' - Recent
+ - Favorite

My projects

E------l'_'h‘thf_lr projects
=+ - Stored Searches

User: kalpert {Logout) (Edit) (Report a problem)

Advanced

Home

New *™

Upload v

Administer ~

Tools =

PROJECT: Test Project > SUBJECT:BP27214 > 080427_BP27214

MR Session: 080427_BP27214

.iiw i Projects

Accession # MUNDA_EQ0S00 Subject: BP27214
Date Added 2011-11-22 18:30:44.0 Gender:
(kalpert) Handedness:
Date: 2008-04-27 Age:
Time: 11:06:3%
Dperator: 15 A5
Scanner: MEDPC SIEMENS TrioTim
Acquisition
Site: Washington
Motes:

Actions

& edit

View

Upload

Download
PP Email
¥ Share

dﬁ Launch Pipeline
= Manage Files
-2 Delete

4
F
k

K

Navigate to your MR Session page, select “Launch Pipeline”

from the Actions Menu
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Step 3: Check Pipeline Status

N ! ! N D 0 User: kalpert {Logout) (Edit) {Report a problem Advanced

Morthwestern University Neuroimaging

Data Archive .
| Home MNew ~ Upload ~ Administer ~ Tools ~ |
:—--Prujects PROJECT: Test Project > SUBJECT:BP27214 > 080427 _BP27214
+} Recent MR Session: 080427_BP27214
+!- Favarite

Active Processes

i My projects

StdBuildNunda: Running 37.2545 Start Time: 2012-02-23 09:32:52.0

b Other projects

+ Etored Searches S SciE Actions
&/ Data Accession #  NUNDA_E00300 Subject: BP27214 & eai
View r
2011-11-22 18:30:44.0 Gender:
Date Added (kalpert) Handedness: Upload ’
Date: 2008-04-27 Age: - Download b
Time: 11:06:39 4 Email
Operator: J5 AS P share
Scanner: MEDPC SIEMENS TricTim ﬂﬁl Launch Pipeline
Acquisition
Site: Washington 3 Manage Files
-5 Delete
MNotes:

Note the pipeline is listed as a “Running” Active Process.
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Step 4a: View Reconstructions
N

Reconstructions

ID Type Base Type
MPRAGE_GU_n2_NUNDA_EOOD900 MPRAGE_GU_n2 MPRAGE
T2_NUNDA_EOD900 T&wW T2W

TSE_NUNDA_EO0900 TSE TSE
BOLD_NUNDA_EO0900 BOLD BOLD
ADFP_NUNDA_EODS00 4dlfp 4dfp

Files 0go427_BP27214_study2_fl3d1_2.4dfp.hdr
080427_BP27214_study2_fl3d1_2.4dfp.ifh
0B0427_BP27214_study2_fil3d1_2.4dfp.img
0B0427_BP27214_study2_fil3d1_2.4dfp.img.rec
080427_BP27214_studyd_tfl3d_4.4dfp.hdr
080427_BP27214_study4_tfl3d_4.4dfp.ifh
0B0427_BP27214_study4_tfl3d_4.4dfp.img

Once the pipeline has finished, you can check for output files under
the “Reconstructions” area of the MR Session report page...



Actions

% edit

View » _\

uplﬂﬂd 3 j File Manager
in,
g + & Ld SNAPSHOTS 2 files, 154 Kb GIF SNAPSHOTS ™

Download » =3 [#] [ reconstructions |

M Email :] _.Efjnpmse GU_n2_NUNDA_E00900 MPRAGE_GU_n2

b ek [+ @ 3 paTA 75 files, 888.87 Mb 7
dre — . [@ [ T2_NUNDA_E0DS00 T2W
f Launch Pipeline E [+ 3 DATA 23 files, 118.03 Mp 7%
@ [ TSE_NUNDA_E00S00 TSE
- Manage Files - |+-@ A patA 9 files, 192.01 Mp #8
oyl @ [ BOLD_NUNDA_E00S00 BOLD
Delete e

+E 3 movement 6 files, 77 Kb -

+E [ atlas 54 files, 162.79 Mb 7o
+@ [ boldrun1 33 files, 463.21 Mb 7%

. 4 ¥ [ boldrun2 33 files, 463.21 Mb 7*

. [@) [ 4DFP_NUNDA_E00S00 4cifp
+E | StudyLookUpFile 1 files, 915 bytes -
++@ [ 40fp_study2 4 files, 16.05 Mb 7%
+ @ [ adfp_stucy? 4 files, 16.05 Mp 7
+ @ [ adfp_stucy4 4 files, 44.03 Mp 7
+@) [ 40fp_studys 4 flles, 44.03 Mp 7%
++@ [ 40fp_study6 4 files, 44.03 Mp 72
+@) [ 40fp_study8 4 fles, 9.01 Mo =% v

—_— a

| Add Folder || Upload Files | rzip ;]‘ | Download || Close |

T et RN Ty

& t2_spc_imm_p2 usable  DICOM (176 flles, 32.38 Mb) SNAPSHOTS (2 files, 649 Kb)
Or you can peruse the Reconstructions from the “Manage Files”
section of the “Actions” menu.
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Step 4b: View Assessors

Experiment Label Date

Pr-njn:t

FSEG_MUNDA_EDOS00

Some pipelines output
Assessors in addition to
Reconstructions. You’ll find
these under the
“Assessments” area of the
MR Session report page,
and clicking them will take
you to an Assessor report

page.

2011-11-23 Test Project
-1-0_NUNDA_E00S00 2011-11-29% Test Project
0900 2012-01-10 Test Project

NUNDA

User: kalpert {Logout) (Edit) {Report a problem) fa.ID Advanced

thwestemu niversity Neuroimaging

Data Archive

‘ Home New ™ Upload

Administer ~

Tools ¥ ‘

SUBJECT:BP27214 > SESSION:080427_BP27214 >

Freesurfer Analysis Details

MRSession 080427_BP27214

Date 2011-11-29

Time

Note

(v} FS_v5-1-0_NUNDA_EDOS00
Project TP

Freesurfer version freesurfer-Linux-centos4_x86_64-stable-pub-v5.1.0

El ASEG Measures

cv 1426714
Left hemi. cortical gray matter vol. 244938
Right hemi. cortical gray matter vol. 243619
Total cortical gray matter vol. (based on surface-stream) 488556
Subcortical gray matter vol. 168271
Total gray matter vol. 656827
Supratentorial vol. 1024964
Left hemi. cortical white matter vol. 225002
Right hemi. cortical white matter vol. 222663
Total cortical white matter vaol. 447685
Region Name Seg Id Hemisphere NVoxels Volume
Left-Lateral-Ventricle 4 left 3752
Left-Inf-Lat-Vent 5 left 470

FS_v5-1-0_NUNDA_E00900

Actions
7 edit
View
Download XML

PP Email

3 pownload stat Files  *

30.B316 +-1:

Mean Range
4.1804 74 (5-79)
36.2080 +-17.5742 74 (8-82)




Actions

% edit .

File Manager
View » _
uPlnad , '_..E [ assessors F
—.[# 3 FsL_Seg

Download 4 — @ 3 pATA 12 files, 55.60 Mb 5
H E ma i I """ 080427_BP27214_mpr_n2_111_tB8_gfc_bet.nii.gz 2.95 Mb -
* cehare = | M 080427_BP27214_mpr_n2_111_t88_gfc_bet_fseg.hdr 348 bytes -

dre
""" 0B0427_BP27214_mpr_n2_111_t88_gfc_bet_fseg.img 24.58 Mb -

f I-ﬂ u n:h FiPEI i ne | i 080427_BP27214_mpr_n2_111_tB8_gfc_bet_mixeltype.nii.gz 391 Kb -

""" 080427_BP27214_mpr_n2_111_tB8_gfc_bet_pwve_0O.nii.gz 841 Kb -

- Manage Files

""" 0B0427_BP27214_mpr_n2_111_t88_gfc_bet_pwe_1l.nii.gz 1.32 Mb -

. g‘ nEIEtE """ 0BO427_BP27214_mpr_n2_111_t88_gfc_bet_pwe_2XLnii.gz 651 Kb -

""" 080427_BP27214_mpr_n2_111_tB8_gfc_bet_pwveseg.nii.gz 327 Kb -4
----- 080427_BP27214_mpr_n2_111_t88_gic_bet_seg.mat 150 bytes 7
""" 080427_BP27214_mpr_n2_111_tB8_gfc_bet_seg.nii 24.58 Mb -

""" 080427 _BP27214_mpr_n2_111_t88_gfc_fseg.txt 4 Kb -

E """ fseg.prop 93 bytes -
E
B
B
E
E
B
E
E
B
B
E
E
B

—|.[# 3 Freesurfer

+:[# [d paTa 428 files, 339.91 My 75
—.[# [J BOLD_QC_NUNDA_ED0900 Auto QC

+- [ Qc_mov 4 files, 66 Kb GIF MOVEMENT 7
+-[ [A Qc_hist 4 files, 60 Kb GIF HISTOGRAM 7*
+! @ [ qc_Mprage 2 files, 235 Kb GIF MPRAGE 7o 4

| Add Folder || Upload Files zip Q‘ | Download || Close |

Or you can peruse the Assessors from the “Manage Files” section of
the “Actions” menu.



- NUND Live Demo

Kate Alpert



- Future Directions

Where we are heading with NUNDA pipeline
processing



https:/ /nunda.northwestern.edu/

Pipeline Release Date: May 1°¢

While we have preliminary pipelines on NUNDA
now, we're making some changes before we
officially release the pipelines

Setting most preferences at the project-level as
opposed to the session-level

Initializing the FreeSurfer Pipeline with DICOMs as well
as reconstructed MPRAGE

After we've implemented these changes, we plan to
introduce the pipelines to the entire NUNDA
community (Data Blitz / May 1)



https:/ /nunda.northwestern.edu/

Automatic Pipeline Processing

We are also hoping to implement an option for
automatic pipeline processing by project

NUNDA user would select “Run pipeline automatically
on all sessions” within a project

All existing sessions and any sessions added after this point
would automatically be run through the selected pipeline(s)

Cron job would inspect the database for unprocessed
sessions and shoot off pipelines as necessary

ISSUE: we need all parameters to be set at the project
level



https: / /nunda.northwestern.edu/

New Pipelines

We are excited to work with the NUNDA community
to adapt processing streams into pipelines on

NUNDA
Request at NUNDA.Admin@northwestern.edu
Register at https:/ /nunda.northwestern.edu/

EOTOT I T T BT eTT T S TOT T OSSO Ly ST T T 1T

axploring and accessing the data. Access to data in the NUNDA is
restricted to users authorized by the specific study's investigators.
The NUNDA is hosted by the Neuroimaging & Applied

- - - - Computational Anatomy Lab, and it is modeled after the
NUrthWES_tem University Neuroimaging Washington University's Central Neurcimaging Data
Data Archive Archive (CNDA).

For more information, please contact
NUNDA_Admin@northwestern.edu. The NUNDA is powered by
User XMNAT. an open source software package for managing neurcimaging
and related data.

Password

UNDA User Guide

=gaiarly undergeoing scheduled maintenance in the
off-hours (7pm - 7am). Maintenance does not take more than an

Forgot login or password? hour at a time. During maintenance NUNDA is not available for
access.




